
Classic

The iMac Q&A

iMac Tips Section
iMac Tips for you to enjoy!

If you are new to the iMac, pick up a copy of "The Little iMac Book" by

Robin Williams, published by Peachpit Press. This book will show you how to go
many things with the software which came with your iMac. For $17.99 (US) I feel it
is worth it to help you

Microsoft Office 98 for Macintosh has a self-healing feature. If some part of it

is removed from the System folder, it will place that part back. Microsoft's Windows
OS and applications (Office 97) does not do this.

Of course it appeared on the Mac first!

I heard about doubling your Virtual Memory in a 32MB iMac can effectively

double its speed! Cool, just remember that physical memory is always faster than
virtual memory.

Q. How do I setup Speech Recognition on my iMac?
(Only if you are using Mac OS 8.1 - 8.5)

 A. First you need to obtain the iMacPlainTalkEnabler at -> MacSpeech

Then:
Install the English Speech Recognition software from your Mac OS 8.5 CD. I have not

found it on my Mac OS 8.1 iMac Software Restore CD.
Newer versions are available from http://asu.info.apple.com/swupdates.nsf/artnum/n11288

(This will load the SpeakableItems and Speech Recognition Extensions,
plus the Speech Control Panel.)

Install the iMacPlainTalkEnabler Extension.

After you reboot the iMac, open the Speech Control Panel.

Select the Speakable Items option, turn it on. You will see the "person" who you will be
talking to appear in a window.

Close the Speech Control Panel.

The default setting for PlainTalk is to press and hold the Esc key while talking a command out.
All of the commands are located in the Speakable Items folder.

Help:
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Q. How do I change my Umax Scanner default file format in the Umax VistaScan DA?

A. I use the Umax VistaScan DA 3.1 application which came from the updated driver set off of
Umax's web site.

On the upper far right (next to the question mark), click on the
o-
o- icon.

Select the Scan Destination tab

From there you can change the file format to JPEG, GIF, and PhotoShop among
others. There is a tab where to tell it what application to send it to, with which
file format.

If you use the Presto! PageManager application, It likes to use one kind of
file format and convert it to another when you move the image to a different
application. You cannot change what Presto! PageManager likes.

Q. What is the file Mac OS ROM used for?

A. Inside of your System Folder you have a file called "Mac OS ROM".
This file contains a portion or the whole (I have heard both sides) of the Mac ROM chip, which
controls windows, startup routines and has special stuff for the iMac. You need this file when
you start up an iMac.
On the iMac they created a file, on most other Macs this is on the motherboard in a real ROM
chip.

Q. How can I go more powerful searches in Sherlock?

A. Allocate more memory to it. If you have many search places to look through 1024MB is
small for Sherlock to work.
How to:
In the Finder-

 Double click on your hard drive

 Double click on the System Folder

 Double click on the Apple Menu Items folder

 Click once on Sherlock

 Select the File menu, then Get Info, then General Information or (Command I)

 Change General Information to Memory

 Change the Preferred Size to 2048 or larger.

 Close the Sherlock Info window.
That's It!
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Q. I have heard that I might need to use a paperclip with my iMac, huh?

A. If your iMac locks up and you need to restart it, you will find a reset hole on the side of
your iMac.

Underneath the purple arrow

Press it gently with a paper clip, the iMac will restart.

Q. My iMac flashes a folder during startup, is that a problem?

A. The reason it does it is because there is no startup disk selected in the Startup Disk Control
Panel. It has to select an available hard drive, which takes about 1-2 seconds.
Once the HD is selected the boot process is faster.
The Startup Disk Control Panel is in the Control Panel folder under the Apple Menu.

Q. My local store ran out of iMacs, help!

A. I can't help you out here, I have found in smaller communities iMacs are not as in
demand as the larger areas. Around here, 1 store had 4 left, the other had 10 or so on
opening day.
Around here on opening day we had no crowds, no free cake, no free t-shirts, and no free
balloons! I feel I got ripped off!
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A. You can have the iMac and a Windows PC share files. First we will look at the built-in
peer-to-peer networking, use Virtual PC or with a file server.
Peer-to-Peer:

To have the iMac and the Windows 95/98 PC see each other, you have two options.

Make the iMac use the Windows 95/98 protocols. To do this, get a copy of DAVE

from Mac Connection or Mac Warehouse.
Here is the spec sheet from the manufacturer - http://www.thursby.com/dave2/psheet/

Make the Windows PC use the Macintosh protocols. To do this, get a copy of Mac-Lan

from Mac Connection or Mac Warehouse.
Here is a review of it from a independent place -

http://www.newmedia.net/Reviews/maclan.html
 Here is the manufacturer's URL - http://www.miramarsys.com/

Using Virtual PC:
 You also can use Virtual PC with Windows 95 or 98 and have it use its peer to peer network-
ing with other Windows 95 PCs.

File Server:
 If you have Windows NT Server or Novell NetWare, use the server's built-in Macintosh
support to set them up as a file server.

Q. How can I get my iMac talking with a Windows PC?

Q. My iMac freezes up on startup. What can I do to fix this?

A. Try booting with all extensions off (a shortcut is to hold down the shift key at startup until you
see the message Extensions disabled).
If that works, have the Extensions Manager (located in the Control Panel) turn off everything
except the Mac OS 8.0, 8.1 and iMac packages (see below for an explanation of a package). If
that does not work, you probably will have to use the iMac software restore CD. :(
If that does work, start adding extensions and control panels until it hangs. (My recommendation
is to document which packages have which CP/Extensions)
If the 8.0, 8.1 and iMac does not work, try to isolate which package is causing the problem.
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Once you find which package is causing the problem, replace all CP/Extensions in that
package.
Remember: In the Extensions Manager you can change the view to package by using
the View menu.
An explanation of the packages: It is a way to view a bunch of Extensions & Control Panels
as a whole update. The Extension Manager Control Panel will list updates like Mac OS 8.0,
Mac OS 8.1, iMac, OpenDoc 1.2.1, etc. The default view lists each Control Panel and Exten-
sion in the "Folders" view.
So if you wanted to disable a whole package, you could with one "x" instead of checking 14
different Extensions and Control Panels.

Q. I need to clean my iMac mouse.

A. To open the mouse:
♦ Turn it over, under the words "Apple USB Mouse" there are two grip pads.
♦  Press down on both with two fingers and turn counter-clockwise to open it.
♦  Remove the mouse ball.
♦  Use an eraser to clean the dirt that has accumulated on the rollers.
♦  Blow into the mouse to clear away any excess dirt.
♦  Place the ball and the cover back.

That's it.

Q. How do I change my iMac Modem Script?

Copy the script to the Modem Script folder
♦  Double click on the compressed archive to extract the file "iMac Internal 56" (if it is still
in the compressed state)
♦  Double click on your iMac hard drive

♦  Double click on the System Folder

♦  Double click on the Extensions folder

♦  Double click on the Modem Scripts folder

♦  Copy the "iMac Internal 56" modem script to the Modem Scripts folder
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 Change to the new modem script

♦  Open the Modem Control Panel 

♦  Then select the iMac Internal 56 script

♦  Close the Modem script and click the Save button
♦  Connect to your ISP again.

Q. I need to zap the PRAM in my iMac, how can I do this easily?

A. You can get a free utility from Micromat, the manufacturers of TechTool Pro. This will
let you zap the PRAM as well as saving and restoring it.

Go to Micromat's web site at http://www.micromat.com/micromat/main.html

Go to the Download area, then scroll down until you find the TechTool 1.1.7 (1M)

Download it

Q. My Sherlock plug-ins cannot be searched with. Where do they go?

A. They go into the Internet Search Sites folder 

This folder is located in the System Folder 
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Networking:

Q. How can I share a folder in my iMac?

A. Shared folders can be useful for many things. This works with Mac OS 8.5, Mac OS 8.1
should be similar.
How to:
In the Finder-

 Click on the shared folder you want to start/stop file sharing

 Press the Command-I keys (Or File menu, Get Info Information)

 Switch the Information to Sharing in the Show box.

 (The iMac will help you open the File Sharing Control Panel to start up File Sharing if it
is not on.)

 Uncheck "Share this item and its contents".

Q. Can I network a scanner with my iMac?

A. The only way I know you can make a scanner do this is if your scanner has a network
option.

For example, the Umax 610s has a LocalTalk network option. The scanner hooks up through
the SCSI port, then there is a control panel or extension which does all of the work of send-
ing and receiving information over LocalTalk. You use the scanning application like normal
on the iMac. The first I have seen for any scanner.
The Umax 1220U for the iMac lets you share this scanner over a network too!!

Another way is to use a remote control software like Timbuktu Pro. I have been using that so
my iMac can control my Performa in a window on my iMac. I can then controla any
program, except the Apple Video Player.

Q. I need to print to a LaserWriter from my iMac which has no Ethernet port. What can I do?

A. You can purchase a Ethernet  to LocalTalk bridge or use the free LaserWriter Bridge
from Apple on an older Macintosh. By using an older Mac to be a bridge, the other
Macintosh can be the universal answer for some of the iMacs most outspoken prob-
lems.

Q. I have a bunch of SCSI devices I need to hook up to an iMac?

A. I have a Zip drive, and two external drives hooked up to another Macintosh which
had the Personal File Sharing turn on in System (Mac OS) 7.6. I can use all of the
devices over the Ethernet network connection.

Another way is to purchase the USB based version of the SCSI device. Or purchase an
USB to SCSI adapter.
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Q. I have a PC which has files that I want on my iMac. How can I move them over to the iMac.

A. The easiest way is use the built-in Ethernet card in the iMac. Purchase an Ethernet card for the
PC (use 10BaseT if you are on a budget, they range around $17 for the card) and use an Ethernet
cross-over cable to connect the two (about $10). You can also purchase an Ethernet hub around
$40.00 for 10BaseT.
Next is the software. If you have Windows NT, use the Macintosh File Services to set it up the
PC as a file server. If you have Windows 95 or 98, download a FTP SERVER from
www.download.com . There are some shareware ones to use.
The FTP server software will allow your iMac to download the files from your PC FTP server.

Q. How do I hook up an Apple StyleWriter to my iMac through AppleTalk?

I have my StyleWriter I (the original) hooked up to my iMac through Ethernet to my Mac
Performa.
Here is how I did it:

 • Install the printing software on the host Mac (in my case it is a Performa 640CD)
 • Make sure AppleTalk is on and it pointed to the Ethernet port.

o AppleTalk control panel  in Mac OS 8.x -> Ethernet is selected

o Chooser, under the apple menu -> Active is selected
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 • Background printing can be on or off 

  • On the iMac open the Chooser, under the Apple menu
  • Select the StyleWriter 1200 and choose the name you gave it three steps above

  • Print from any application to it.
That is it!

 • Select the StyleWriter 1200 driver in the Chooser, under the Apple menu (see Chooser above)

 • Click on which port, modem or printer 

 • Click on the Setup button. 

 • Click on Share this printer and give the printer a name, a password is optional, Keep Log of
Printer Usage lets you see who is using the printer.

Q. How do I setup my iMac or Mac to become a file server?   What is AppleShare
file server software?

See the AppleTalk-ing section on File Servers -
http://www.athenet.net/~gyounk/filesvr.htm
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Miscellaneous:

Q. How can I check my VRAM?

A. You can open the Apple System Profiler located in the Apple Menu.
Open up the Monitors & Sound control panel.

Set the Monitor resoultion to 1024x768.

If you see Millions under the Color Depth, you have 4 MB or 6MB of video RAM. If
not you have 2MB.

The only other way is by opening it iMac up. That can be dangerous if you don't know to
open the iMac up. I will suggest that you take it to an Apple dealer so you won't void your
warranty if a whoops happens.

Q. How can I save an URL on my desktop?

A. This works with Mac OS 8.5 and higher.
Open your favorite browser and type in or select the web site so its address in in the URL

spot.
Select it with the mouse.

Drag it to the desktop., it will become an URL address pointer.
That's it!

Q. Why do I get a PostScript Level 1 error when I print to my LaserWriter?

A. You need to setup the correct PPD file in the Chooser so it will print as PostScript Level 1,
instead of the default which is Postscript Level 2.

Open up the Chooser

Pick the LaserWriter 8 printer driver

If this is the first time setting up the LaserWriter, click on the Create button. It will select
the correct printer driver.

If the printer is already setup, click on the Setup button and then select the Select PPD
button. Choose another PPD file for the LaserWriter.

10



Q. The iMac mouse gets turned around, help!

A. I have found the iMac mouse to be comfortable to use.
Try this:

• Grip it like you are pitching a baseball.
• Put only your first two fingers (not counting the thumb) on the button.
• The cable will be between the first and the second fingers.

Q. I purchased an iMac with no floppy drive. What can I do?

A. First of all see if you really need the floppy drive. If you do, purchase one. I don't find it
necessary if you have a networked connection somewhere. What you can do is have another
Macintosh (PowerPC, 68040, 68030, etc.) become a surrogate floppy drive Macintosh.

Using a remote control product like Timbuktu Professional from Farallon, lets you control
the other Mac as if you were sitting down at it. Enable file sharing on the other Macintosh.
Let the other Macintosh read and write all floppies to a shared hard drive.
Using the network connection you will be able to install any software from the networked
drive. You will find that a couple of programs will not like to be installed that way. That is
another problem.

Q. How can I clear out my History and Cache under Internet Explorer 4.01?
A. In IE, go to the Edit menu, then select Preferences.

• Click on the Web Browser, then Advanced.
• The History and Cache settings are on the same page.
• By selecting zero, it should clear out all of your History and the "Empty Now" button will
empty the Cache.

Q. Can my iMac call another Mac over the phone to share files & printers?

A. Yes, you can use the modem port using Apple Remote Access on the iMac. This will be the
Mac client.

Use Apple Remote Access 3.0 Personal Server (ARA) on the Mac "server". The Mac server
will answer any calls, connect and let you use the peer-to-peer file sharing on the server Mac.
I don't know if ARA will run on an AppleShare file server.

The Apple Remote Access is pre-installed on the iMac.
In a mail order catalog, ARA Personal Server is about $119.99.
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A. After installing Mac OS 8.5, I can't print to my StyleWriter hooked up to a Performa. I
print to the StyleWriter over Ethernet.

Re-install the printer drivers for the StyleWriter family on the iMac. Try again.

If that did not work, re-install the printer drivers on the Performa too for the

StyleWriter family.
FYI: The Mac OS 8.5 read me says for all older StyleWriters should use the Color SW
1500 driver, in Mac OS 8.1 Style 1200 works.

Q. I can't print to my networked StyleWriter, help!
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